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Fast start

This Getting Started guide contains instructions on how to install, 
register, and set up AccountEdge, AccountEdge Plus and 
AccountEdge Plus Network Edition products.

Follow the tasks below to install and begin using your software.

For information on support plans, see What’s new.

Check the system requirements

Hardware and software requirements will vary depending on your 
operating system. Before installing your software, make sure your 
computer is able to run AccountEdge, AccountEdge Plus or 
AccountEdge Plus Network Edition.

Please visit www.mamut.com/uk/mac/system for the most recent 
and up-to-date AccountEdge system requirements.

Task

1 Check the system requirements

2 Install your software

3 Register your software

4 Upgrade your files (existing users only)

5 Set up a company file (new users)

6 Check for software updates

7 What’s new

www.mamut.com/uk/mac/system
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Install your software

If you are upgrading from a previous version, we recommend: 

1 you optimise, verify and backup your company file before you 
begin the upgrade process. For more details, see the ‘Backing up 
and restoring company files’ and ‘Servicing your company file’ 
sections of the Online Help.

2 if you don’t already have a record of it, that you note your 
AccountEdge serial number, which will be required to register 
your 2015 product. To locate your serial number in your current 
product, click the AccountEdge menu at the top left of your 
screen, and select Registration. 

3 you note the name and location of each of your current 
AccountEdge company files. In each of your company files, go to 
the Accounts command centre and select Company Data 
Auditor. Record both the File Name and File Location. This 
information will be required when upgrading your companies to 
AccountEdge 2016.

To install AccountEdge and AccountEdge Plus 

1 If your computer allows only users with administrator privileges 
to install programs, log in as an administrator. 

2 Double-click the downloaded AccountEdgeDMG file to open. 

3 Drag and drop the AccountEdge icon into the Applications 
folder icon. 

4 Double-click the Applications folder icon to view your 
applications and confirm that AccountEdge Version 16 has been 
placed in the folder. 

To Install AccountEdge Plus Network Edition

1 If your computer allows only users with administrator privileges 
to install programs, log in as an administrator. 
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2 If you are upgrading from an earlier version of AccountEdge 
Network Edition, stop FileConnect:

NOTE : Usually only required on the AccountEdge Plus NE host 
computer.

a Ensure all users have quit and closed their AccountEdge Plus NE 
application on all computers. 

b Go to your Mac OS X System Preferences.
c Click the AccountEdge icon in the Other section of the System 

Preferences window. The AccountEdge system preferences appear.
d If FileConnect is running, click Stop FileConnect. 
e Enter the Administrator password and click OK.

3 Double-click the downloaded AccountEdgeDMG file to open. 

4 Drag and drop the AccountEdge icon into the Applications folder 
icon. 

NOTE : Installing AccountEdge Network Edition If you are installing 
AccountEdge Plus NE Version 16 on the host computer for the first time, 
do not customise the installation. This ensures that all critical 
components are installed. 

5 Double-click the Applications folder icon to view your 
applications and confirm that AccountEdge Version 16 has been 
placed in the folder. 

6 Repeat steps 1-6 on each computer on which you use 
AccountEdge. 

7 On the host computer, Start FileConnect:
a Go to your Mac OS X System Preferences.
b Click the AccountEdge icon in the Other section of the System 

Preferences window. The AccountEdge system preferences appear.
c Click Start FileConnect.
d Enter the password for Administrator and click OK.
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Register your software

You will be required to register your software online on each 
computer you install and use your AccountEdge Version 16 product. 
Registration identifies you as the legal owner of the software. Once 
registered you’ll receive information about product upgrades, 
updates, new products, and other services.

After installing your AccountEdge Version 16 product, you will have 
30 days to register. If registration has not been completed within 30 
days, you will not be able to access your company file or sample files. 

Each installation of the software will require you to register. Your 
serial number has attached to it the number of allowed computer 
registrations. Each serial number allows for one registration unless 
additional workstation licenses have been purchased. 

To move your software licence from one computer to another, you 
will need to de-activate your registration on one computer in order 
to register on another. 

How to register
To register, you will need your serial number. Your serial number is 
included in your software package. If you downloaded your software 
after purchasing online, your serial number is in the email 
confirmation you received when you purchased your software. 

To register your software

Registering your software is easy: 

NOTE : You must be logged onto your computer as an Administrator 
to activate your software.

1 Locate and launch your AccountEdge, AccountEdge Plus or 
AccountEdge Plus NE application from your computer’s 
Applications. 
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2 Click the Please Register link on the top of the Welcome window 
or if you are already in your company file, choose Registration 
from the AccountEdge, AccountEdge Plus or AccountEdge Plus 
NE menu at the top left corner of your screen. 

3 Once all required information has been entered, click Register. 
When the registration is complete a confirmation window will 
appear.

4 The date that your license expires will be displayed on the 
Welcome window. You will need to Renew your licence prior to 
expiration in order to continue to use the software. 

5 To Renew your Service Agreement, click Renew License on the 
Registration window. 

Upgrade your files (existing users only)

Company files created with a previous version of your AccountEdge 
or AccountEdge Plus software need to be upgraded to operate with 
your Version 16 product. You also need to upgrade all customised 
reports, forms, letters, and spreadsheets that you used with your 
previous version of the software.

Once you upgrade your company file, you can open it only in the 
Version 16 version of AccountEdge, AccountEdge Plus or 
AccountEdge Plus Network Edition, depending upon which software 
you use.

Task Action

1 Upgrade your customised templates

2 Upgrade your company files
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Task 1: Upgrade your customised templates
If you previously customised reports, forms, letters, graphics, or 
spreadsheets, you need to upgrade these templates to use with the 
AccountEdge Version 16 product. This task should be performed on 
each computer on which you use your AccountEdge product. 

You can automatically upgrade your custom templates using a 
migration assistant (see ‘To automatically upgrade your customised 
templates (recommended)’), or upgrade them manually by copying 
your customised  templates to your AccountEdge Version 16 product 
support folder (see ‘To manually upgrade your customised 
templates’).

To automatically upgrade your customised templates 
(recommended)

1 Locate and launch your AccountEdge, AccountEdge Plus or 
AccountEdge Plus NE Version 16 application from your 
computer’s Applications. 

2 In the Welcome window, click Company File Maintenance and 
select Migrate previous version from the menu. The Migration 
Assistant window appears. 

3 The path to the previous application is displayed. 

NOTE : If ‘Please select your previous AccountEdge application’ is 
displayed If your software was not able to locate a previous 
version, Please select your previous AccountEdge 
application will appear in the previous application field. Click 
Browse and select the location. Next, select the application file (for 
example, AccountEdge 2012) and then click Open. The correct 
path should now be displayed in the Previous Application field.

4 Select Copy Spreadsheets if you have customised Excel 
spreadsheets in addition to forms, reports and letters in your 
previous version. 

5 Click Start. The upgrade process begins.

When the process is complete, the Finished window appears. 
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NOTE : Using AccountEdge on more than one computer If you 
are using your AccountEdge product on more than one computer, 
repeat the above steps for upgrading your custom templates on 
each computer.

To manually upgrade your customised templates

6 Find the AccountEdge 2015 GB support folder located in your 
Documents folder and open it. 

NOTE : Pre-2012 users The customised forms folders can be found 
in the installation folder, (for example 
/Applications/AccountEdge Plus 2011 (v11)).

7 Open a folder containing the customised templates you wish to 
move to your new product. 

8 Select only your custom template files and copy them. 

NOTE : Avoid overwriting standard templates The standard 
templates included with the latest version of your software have 
improved features. To avoid overwriting the new templates with old 
versions, select only the template files that you created or 
customised

Folder File extension Description

Custom 
Reports

*.rpt User-customised report templates

Custom Forms *.frm Standard and user-customised form 
templates, including Invoices, 
Statements, Remittances, and Payslips. 

Letters *.dot, *.docm Standard and user-customised Microsoft 
Word document templates

Spreadsheet *.xlt Standard and user-customised Microsoft 
Excel spreadsheets

Graphics *.bmp, *.gif, 
*.jpg, *.tif, *.png

Any graphics such as company logo, 
employee or item photos, etc.
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9 Paste the template files in each corresponding folder (for 
example, Custom Forms) in the AccountEdge Version 16 GB 
support folder. 

10 Repeat from steps 2 - 4 above for each folder containing 
customised templates. 

NOTE : Using AccountEdge on more than one computer If you 
are using your AccountEdge product on more than one computer, 
repeat the above steps for upgrading your custom templates on 
each computer.

Task 2: Upgrade your company files

NOTE : Upgrading AccountEdge Plus NE Company Files If you are 
using AccountEdge Plus Network Edition, and users access company files 
from a shared location, you need to perform the company file upgrade 
process on the host computer. In step 14 below: AccountEdge Plus NE 
company files can be found on your computer’s hard disk in the 
following folder: Library>Application Support>AccountEdge 
NE>Databases. 

Perform the following steps for each of the company files you wish to 
upgrade for use with your new AccountEdge Version 16 product. 

11 Locate and launch your AccountEdge, AccountEdge Plus or 
AccountEdge Plus NE Version 16 application from your 
computer’s Applications. 

12 In the Welcome window, click Company File Maintenance and 
select Upgrade Company File from the menu. A welcome 
window appears.

13 Click Next. The Find File to Upgrade window appears.

14 Click Find File. The Open window appears. AccountEdge & 
AccountEdge Plus users can find their company file(s) in the 
location they noted in their previous version of AccountEdge, 
described on Install your software.  AccountEdge Plus NE users 
will find their company files in the following location: 
Library>Application Support> AccountEdge NE. 
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15 Select the company file you want to upgrade and click Open. 
The Find File to Upgrade window reappears.

The current path and file name of the selected company file 
appears below the Find File button. The default path and name 
for the upgraded company file appears below the Save As 
button.

16 If you want to change the location or name of the upgraded 
company file:
a Click Save As. The Save As window appears.
b Specify a new location or type a new name and click Save. 

NOTE : Save As location for AccountEdge Plus Network Edition 
users The upgraded file must be saved to Library>Application 
Support>AccountEdge NE>Databases folder found on your 
AccountEdge Plus NE host computer’s hard drive. When saving the 
upgraded file into this folder, we recommend that you additionally 
include ‘Version 16’ in the filename, for example ‘XYZ Ltd Version 16’. In 
this way, you will be able to easily identify your newly upgraded file for 
use with your Version 16 product. 

17 Click Next. The Confirm window appears.

18 Click Next to start the upgrade. When the upgrade is finished, 
the Complete window appears.

19 If you want to upgrade another company file, click Next and 
repeat from step 13 on page 10. 

20 Click Finish to close the Upgrade Assistant. 

Set up a company file (new users)

When you create a company file, you record basic information about 
your business, such as the business name and contact details. You 
must also specify the month and financial year of the earliest 
transactions you want to record.

Depending on the features you want to use, there are some 
additional tasks that you may need to do.
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Essential tasks The tasks you need to do depend on whether your 
accountant has created and set up a company file for you, the 
information you currently have, and when your business started. 

Advanced tasks When you have completed the essential tasks, you 
can start recording transactions. However, if you need to use the 
advanced features of this software, (such as the payroll features) you 
will need to do further setup tasks. These tasks are covered in the 
Online Help files.

Task 1: Create a company file
When you make entries in your software, the information is stored in 
a file called a company file. 

NOTE : Do you already have a company file? If your accountant has 
provided you with a company file, or if you want to use a file created 
with a trial version of this software, you don’t need to create a company 
file.

Task

1 Create a company file

2 Easy setup assistant

3 Set up preferences

4 Set a password for the Administrator 
user ID

5 Set up accounts

6 Enter the account opening balances
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Before you start, you need to know: 

Your current 
financial year

This is the financial year for which you want to start 
recording transactions in your company file. Note 
that a financial year is represented by the calendar 
year in which the financial year ends. For example, if 
your financial year ends in March 2016, your financial 
year is 2016.

The last month 
of your 
financial year

This is the month in which your financial year ends.

Your conversion 
month

This is the earliest month for which you want to 
record transactions. For example, if you want to enter 
transactions dated September 1 or later, your 
conversion month is September. 

You cannot enter transactions dated before the 
conversion month.

The number of 
accounting 
periods in your 
financial year

You can choose to have 12 or 13 accounting periods. 
A 13th period is a period for recording entries which 
you do not want included in the accounting figures 
for a particular month. For example, you can use it to 
record year-end adjustments that are attributed to all 
months. If in doubt, choose 13 periods.

The default list 
of accounts

Accounts are categories to which you allocate each of 
your transactions. When you create a company file, 
you need to specify a default list of accounts. You can:
• start with an accounts list provided by AccountEdge. 

You can select a predefined accounts list suitable for your 
business.

• import a list of accounts. You can import an accounts 
list from another company file, or one that has been 
provided by your accountant or Mamut Partner.

• build your own list. You can start with an accounts list 
that has the minimum accounts required by your 
software and then add to it.

Note that you can modify your accounts list after 
creating your company file.
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NOTE : Some company file information cannot be changed Take 
care when creating your company file as some information—such as 
your current financial year, last month in financial year, conversion 
month, and accounting periods—cannot be changed once you have 
created your company file.

To create a new company file

1 Start your software. A welcome window appears.

2 Click Create new company file. The introduction page of the 
New Company File Assistant appears.

If you have an Open option instead of a Create option, then go to 
the Company File Maintenance menu and select Create company 
file. 

3 Read the information in this page and then click Next. The 
Company Information page appears.

4 Enter the business details as indicated. 

5 Click Next. The Accounting Information page appears. 

6 Enter your financial year details and conversion month. 

TIP : Current financial year This is the financial year for which you want to 
start recording transactions in your company file. It does not need to be the 
financial year that your business is currently operating in. 

7 Click Next. A confirmation page appears.

8 Check the financial year and conversion month and then click 
Next. The Accounts List page appears. 
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9 Select the default accounts list you want to start with.

10 Click Next. An accounts list selection page appears. 

If you choose to... Continue with...

start with an accounts list provided by 
AccountEdge

step 10 below

import a list of accounts step 12

build your own list step 12
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11 Select the industry and type of business that best matches your 
business. 

A suitable accounts list for the business type you selected appears. If you 
want to print the list, click Print. Later, you can tailor the list to meet the 
needs of your business.

12 Click Next. The Company File page appears.

13 If you want to change your company file name and location:
a Click Change. The Save window appears. 
b Select the required location.
c If necessary, type a new file name in the Save As field. 

14 Click Next. Your company file is created and the Conclusion 
page appears.

15 Click Command Centre to display the Command Centre 
window or Click Setup Assistant to continue to customise your 
company file setup.

Task 2: Easy setup assistant 
You can setup your preferences by using the Easy Setup Assistant. 
This assistant guides you through setting up some key preferences. 
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To begin using the Easy Setup Assistant, click Customise. After you 
have finished each section beginning with Customise, Accounts, 
Sales, Purchases, Payroll [AccountEdge Plus users only] click Close. 

If you have completed each section, you can select ‘Do not show me 
the Easy Setup Assistant when I open my file’.

Task 3: Set up preferences
Preferences are settings that enable you to tailor your software to 
your business requirements.

NOTE : Do you need to complete this task? While you can complete 
this task later, you should review the default preferences that have been 
set before you start entering transactions. 

You can set preferences to customise the way your software operates. 
For example, you can choose to automatically print invoices after 
recording them, or prevent transactions from being edited.

You can set up your preferences using the:
 Customise Easy Setup Assistant. This assistant guides you through 

setting up some key preferences. To access the assistant, go to the Setup 
menu, choose Easy Setup Assistant, and then click Customise.

 Preferences window. This window lists all of the preferences. To view 
this window, go to the Setup menu and choose Preferences.

Some preferences you should consider choosing include:
 Use Audit Trail Tracking  If you want to keep a record of 

transactional, tax, account, payroll, and system changes, select this 
option. For more information about audit trail tracking, see your Online 
Help.

 Transactions CAN’T be Changed; They Must be Reversed  If 
you want to prevent transactions from being edited or deleted, select this 
option. When you do want to change or delete a transaction, you will 
need to record a reversal transaction. For more information, see your 
Online Help.

 I Deal in Multiple Currencies If you want to enable multi-currency 
accounting, select this option. For more information about working with 
multiple currencies, see your Online Help.
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Task 4: Set a password for the Administrator user ID
A user ID is the means for:
 controlling access to a company file 

 tracking a transaction record history

 saving individual preferences

When you created your company file, a user ID called Administrator 
was automatically created. 

By default, the Administrator user ID does not have a password 
assigned to it. Anyone who signs on with the Administrator user ID 
will have complete access to all command centres, functions, and 
windows and will be able to create, edit, and delete other user IDs. 

For that reason, as soon as you create a company file, you should 
assign a password to the Administrator user ID; otherwise, anyone 
can sign on and then enter, edit, and delete transactions in your file.

To set a password for the Administrator user ID

1 Start your software. The Welcome window appears.

2 Open your company file using the Open or Browse option and 
bring yourself to the Sign-on window.

3 Click Change Password. The Change Password window 
appears.

4 In the Change Password window, leave the Existing Password 
field blank, type the password in both the New Password and 
Confirm Password fields. 

5 Click Record.

NOTE : User access restrictions If you want to restrict other users from 
accessing certain features or information, you can create additional user 
IDs and specify their access restrictions. For more information, see the 
‘Managing user accounts and company files’ chapter in the Online Help.

Task 5: Set up accounts
Accounts provide a means for grouping similar transactions. For 
example, if your business pays rent for the use of its premises, you 
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would create a rent account and then allocate all rent payments to 
that account.

The accounts you use for your business are grouped in an accounts 
list.

NOTE : Do you need to complete this task? If your accountant or 
Mamut Partner has provided you with a company file, this task may 
have been completed for you. In this case, go to ‘Enter the account 
opening balances’.

When you created your company file, you selected a default 
accounts list to start with. This list may already have the accounts you 
need. If not, you can change the list to suit your needs. If you are 
unsure, ask your accountant which accounts you should create, edit 
or delete.

If you chose to import a list of accounts, you should import this list 
now. For information about importing data into your company file, 
click the Help button in this window.

Account numbers Each account is identified by a unique five digit 
number. The first digit indicates the account’s classification (for 
example, accounts starting with 1 are asset accounts). The 
remaining four digits determine its location within the classification. 
The lower the number, the higher up in the list it appears. For 
example, account 1-1100 appears above 1-1200. 

Account classifications and types The accounts list groups accounts 
into eight classifications—Assets, Liabilities, Capital, Income, Cost of 
Sales, Expenses, Other Income, and Other Expenses. Within each 
account classification there is at least one account type. 

Account classifications and types are described in the following table.

Classification Type Description

Asset 
(1-xxxx)

Bank Money in the bank, for example, in a 
Current chequing or savings account.

Accounts 
Receivable

Money owed to you by your 
customers.
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Other 
Current 
Asset

Assets that, if required, can be turned 
into cash within a year. These may 
include your term deposits.

Fixed Asset Assets which have a long life, for 
example, buildings, cars, or 
computers. Fixed assets are usually 
depreciated.

Other Asset Other assets you own, such as loans 
made to others and goodwill.

Liability
(2-xxxx)

Credit Card Repayments to service credit card 
debt.

Accounts 
Payable

Money owed by you to your 
suppliers.

Other 
Current 
Liability

Money owed by you that is due in 
less than a year, for example, tax. 

Long Term 
Liability

Money owed by you that is due in 
more than one year, like a business 
loan.

Other 
Liability

Other money you owe.

Capital 
(3-xxxx)

Capital The business’s net worth, that is, its 
assets minus its liabilities. Common 
capital accounts are current year 
earnings, retained earnings, and 
shareholders’ capital.

Income
(4-xxxx)

Income Revenue from the sale of goods and 
services.

Cost of Sales
(5-xxxx)

Cost of 
Sales

The direct cost of selling your goods 
and providing services, for example, 
purchase costs and freight charges.

Classification Type Description
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Header accounts Your accounts list consists of detail accounts (the 
accounts to which you allocate transactions) and header accounts. 
Header accounts group related detail accounts to help you organise 
your accounts list.

For example, you could group your telephone, electricity, and gas 
expense accounts using a Utilities header account. This makes it 
easier for you to locate the utility expense accounts in the accounts 
list and to see your combined utility expenses.

You group accounts by indenting the detail accounts located directly 
below a header account.

Note that:
 You cannot allocate transactions to a header account. 

 The balance of a header account is the sum of the detail accounts 
indented directly below it. 

 You can create up to three header account levels.

Expense
(6-xxxx)

Expense The day-to-day expenses of running 
your business, for example, utility 
bills, employee wages, and cleaning.

Other 
Income
(8-xxxx)

Other 
Income

Other revenue, for example, interest 
earned on savings and dividends paid 
from stocks.

Other 
Expense
(9-xxxx)

Other 
Expense

Other expenses, for example, interest 
charged.

Classification Type Description

Header 
accounts

Detail 
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Setting up accounts

To create an account

1 Go to the Accounts command centre and click Accounts List. 
The Accounts List window appears.

2 Click New. The Edit Accounts window appears.

3 If you want to create a header account, select the Header 
Account option.

If you want to... See

Create an account below

Group detail accounts with a header account To group 
detail 
accounts 
with a header 
account

Delete an account Online Help

Change the details of an account Online Help

Import an accounts list Online Help
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4 Select the account type from the Account Type list. The Account 
Classification field changes according to the selection you make. 
For more information on account classifications, see ‘Account 
classifications and types’.

5 Enter a four-digit number for the account in the Account 
Number field. The number must be unique within each account 
classification.

6 Press TAB and type a name for the account. 

7 Click the Details tab.

8 If you want, type a brief description of the account in the 
Description field.

9 If you are creating an asset, liability, or capital account (other 
than an asset that has the account type of Bank), select an option 
from the Classification for Statement of Cash Flows list.

Classifying accounts allows you to generate a statement of cash 
flows. This report shows how your cash position has changed 
over time, profit earned, and where your cash was spent. If you’re 
unsure about which classification to use, consult your accountant 
or a Mamut Partner.
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10 If you are creating a bank or credit card account, and you want to 
keep a record of your bank account details, click the Banking tab 
and enter your account details.

11 [Detail accounts only] If you want to enter historical balances, 
click the History tab and complete the Last FY column. That way 
you can compare the year’s monthly account balances with those 
of the corresponding months last year.

12 [Detail accounts only] If you want to set up a budget:
a Click Budgets. The Prepare Budgets window appears. 
b Type the budget amounts in the monthly columns.
c Click Close.

For more information about budgets, see your Online Help

13 Click OK when you have finished. The account you created now 
appears in your accounts list. 

To group detail accounts with a header account

You group accounts by indenting the accounts located below a 
header account. You do this by clicking the Up button or the Down  
button located at the bottom of the Accounts List window.

1 Go to the Accounts command centre and click Accounts List. 
The Accounts List window appears.

2 Select the detail account you want to group. 

3 If you want to group the account with the header account 
located immediately above it, click Down. 

4 If you want to group the account with a header account above 
the current header account, click Up.

Task 6: Enter the account opening balances
Account opening balances are the balances of your accounts as at 
the first day of your conversion month.

NOTE : Do you need to complete this task? If you were in business 
prior to your conversion month, most of your accounts probably already 
have balances. If you want to produce financial reports that included 
these balances (such as a balance sheet), or you want to track the 



   2 5

balance of accounts with a cumulative balance (such as your bank 
account), you need to enter these balances. 

You can find your account opening balances on a trial balance 
report, a balance sheet or a profit & loss report prepared for the 
period immediately prior to your conversion date. You can ask your 
accountant to prepare these reports. You may also be able to find 
your account opening balances using your previous software or 
paper-based records.

The balances you enter in your accounting software depend on 
whether your conversion month is also the first month of your 
financial year. 

If your conversion month:
 is the first month of your financial year, enter the opening balances of 

your asset, liability, and capital accounts only. The opening balances of 
your income, cost of sales, and expense accounts should be zero.

 is not the first month of your financial year (for example, if your 
financial year starts in April but your conversion month is August), enter 
the opening balances of all your accounts.

Opening bank account balances You can enter either of the following 
amounts as the opening balance of a bank account:
 the bank account balance that appears on your balance sheet or trial 

balance reports as at the day prior to your conversion date. For example, 
if your conversion date is January 1, 2016, this is the bank account 
balance as at December 31, 2015. 

These reports can be provided by your accountant, or you can obtain the 
balances using your previous software or paper-based records.

 the chequebook balance of the account as at the end of the day prior to 
your conversion date. You can calculate your chequebook balance by 
taking into account the transactions not yet cleared by your bank as of 
the conversion date and the balance that appears on your bank 
statement at that date. 

For example, assume that £500 worth of deposits and £1000 
worth of payments were unpresented as at your conversion date 
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(that is, they had not appeared on a bank statement). The 
chequebook balance would be calculated as shown below:

To enter opening balances

1 Go to the Setup menu, choose Balances and then Account 
Opening Balances. The Account Opening Balances window 
appears.

2 Enter the balances in the Opening Balance column.

NOTE : Enter opening balances as positive numbers Don’t, for 
example, enter liability account balances as negative numbers. Enter negative 
amounts only if accounts truly have negative balances. 

3 Check that the amount in the Amount left to be allocated field 
at the bottom of the window shows £0.00. 

If this field displays an amount other than £0.00, check your 
opening balances again because they are either incomplete or 

Bank statement balance as at the conversion 
date

£21,000.00

ADD uncleared deposits + £500.00

SUBTRACT uncleared payments – £1,000.00

Chequebook balance as at the conversion date £20,500.00
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incorrect. However, you can continue the setup process if there is 
an amount in the Amount left to be allocated field. The amount 
will be assigned to a special capital account called Historical 
Balancing.

4 Click OK.

Check for software updates

To make sure you are using the current version of your accounting 
software, you should check every so often to see if any updates or 
upgrades are available.

To check for updates, open your company file, then go to the 
AccountEdge menu and click Check for Updates.
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What’s new

The following new features and enhancements have been included 
in this release: 

Feature Description

Advanced Filters 
for Registers

• Bank Register
• Sales Register
• Purchase Register

Void Cheque A seamless way to void any kind of 
cheque; mark it as reconciled, identify it 
using Transaction Journal and Recap 
Transaction, put a ‘rubber stamp’ on the 
transaction window and print the 
cheque.

Departments 
added to Bank 
Deposits

If more than one department has been 
added to a transaction, Split will appear 
in the Department field.

Tracking Leads Create a lead card to begin tracking 
potential customers.

Update 
AccountEdge 
date

Easily change the date in AccountEdge. 
If the date in the program is different 
than the current date in the system an 
alert message displays.

Previous and Next arrows have been 
added to quotes, orders, invoices and 
bills for easier navigation without having 
to close the window.
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Purge 
Sale/Purchase 
Quotes and 
Cards

A new purge button has been added to 
the Cards List menu to purge lead, 
customer and supplier cards. This 
button will take you to the Purge Sales 
Quotes and Cards or the Purge 
Purchase Quotes and Cards assistants.

HMRC changes [For AccountEdge Plus and Network 
Edition users only]
• Student Loan Deduction changes 
• Scottish Rate of Income Tax
• NIC Category (Letter) changes - End 

of Contracting Out
• Apprentice NIC category
• Flexible Pension Drawdown 

payments
• RTI FPS part of the Contracting
• Employer Allowance

Departments 
added to 
Inventory 
Adjustments

If more than one department has been 
added to a transaction, Split will appear 
in the Department field.

Reports • 7 Years Historical reporting
• Profit Analysis reports
• Lead reports

Feature Description
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Advanced Filters for Registers

New filters have been added to the Bank, Sales, Purchases and Find 
Transaction Registers to give flexibility when searching for a 
transaction within the registers. 

You can filter your search using the Search by and Dated From 
fields. If you want to narrow your search further:

a Click Filters. The Advanced Filters window appears. The 
Clear Filters button will become active when a filter has been 
selected. Clicking this button will clear any previously selected 
filters.

b Type or select the additional search filters. 
c Click OK to accept the changes made and close the window. 

Back to What’s New 

Void Cheque

Void Cheque allows for a seamless way to void any kind of cheque, 
mark it as reconciled, identify it using Transaction Journal and Recap 
Transaction, put a ‘rubber stamp’ on the transaction window and 
print the cheque.

A Void Cheque option is available in the Edit Menu and in the right-
click menu for Spend Money, Spend Retainer, Pay Refund, Pay Bills, 
Pay Employee, Pay Liabilities, and Bank Register (Spend Money and 
Pay Bills only) transactions.

Transaction Journal and Recap Transaction will show the transaction 
as VOID and the Memo field is updated on each transaction. 
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To void a new cheque

If you find that one of your cheque forms is damaged and not usable 
for printing or that you have made a mistake when writing the 
cheque manually, you may want to void a cheque.

You can void a cheque if the cheque was damaged before recording 
it in your company file, if a recorded transaction is changeable and 
non-changeable. Follow the steps below to void a cheque that you 
have not recorded in your software. If you want to make changes to 
a cheque you have already recorded, see ‘Changing or deleting a 
transaction’.

1 Go to the Banking command centre and click Spend Money. 
The Spend Money window appears.

2 Choose the bank account from which you want to void the 
cheque. 

3 In the Cheque # field, type the number of the cheque you want 
to void.

4 Leave the Amount field and the account allocation fields blank.

5 Go to the Edit menu and select Void Cheque. 

6 Click OK to confirm you want to void the cheque. A VOID stamp 
will appear on the cheque in the Spend Money window. 

7 Click Record.

To void a new cheque from the Bank Register

1 Go to the Banking command centre and click Bank Register. 
The Bank Register window appears. 

2 Choose the bank account from which you want to void the 
cheque. 

3 In the Type field, select Spend Money or Pay Bill. All other 
selections do not offer the void cheque option. 

4 In the Cheque No. field, enter the number of the cheque you 
want to void. 

5 Go to the Edit menu and select Void New Bank Register 
Cheque. 
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6 Click OK to confirm you want to void the cheque. The cheque 
transaction will appear in the Bank Register window and will be 
marked VOID. 

7 Click Record. 

To void a recorded cheque that is marked changeable

If you want to make changes to a cheque you have already recorded, 
see ‘Changing or deleting a transaction’.

1 Go to the Banking command centre or to Find Transactions to 
locate the cheque you want to void. 

2 Choose the bank account from which you want to void the 
cheque. 

3 Click on the zoom arrow of the cheque you want to void. The 
recorded cheque appears. 

4 Go to the Edit menu and select Void Cheque. 

5 Click OK to confirm you want to void the cheque. A VOID stamp 
will appear on the cheque. 

6 Click OK to accept the changes and close the window. 

7 The voided cheque will now appear in the Bank Register or Find 
Transactions window as VOID. 

To void a recorded cheque that is marked unchangeable

If you want to make changes to a cheque you have already recorded, 
see ‘Changing or deleting a transaction’.

1 Go to the Banking command centre or to Find Transactions to 
locate the cheque you want to void. 

2 Choose the bank account from which you want to void. The 
recorded cheque appears. 

3 Go to the Edit menu and select Reverse Cheque Transaction. A 
reversal of the cheque will appear. Notice the amount of the 
transaction has been removed. 

4 Click Record to record the reversal and close the window. 
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5 The original transaction and the reversal are displayed in the 
Bank Register or Find Transactions window, both marked 
VOID. 

Back to What’s New 

Departments added to Bank 
Deposits

A department field has been added to the Prepare Bank Deposit 
and Bank and Deposit Adjustments windows. If more than one 
department has been added to a transaction, split will appear in the 
department field. The amounts of each department selected must 
equal the total amount of transaction. 

NOTE : Assigned multiple departments to a transaction If you 
assign a department or multiple departments to a transaction you 
must first select the preference I Use Departments; if 
Departments Are Not Assigned to All P&L Accounts 
Warn, Don’t Warn [System-wide]. 

To assign multiple departments to a bank deposit

1 Go to the Banking command center and click Prepare Bank 
Deposit. The Prepare Bank Deposit window appears.

2 Select from the transactions listed the amounts you want to 
deposit. 

3 If you want cash back from your deposit enter the amount and 
assign the account for this transaction. 

4 Click in the Dept field. The Allocate Departments window 
appears displaying the departments already created. 
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5 Select either Amount or Percentage. The amount of the cash 
back entered will be displayed as the amount left to be allocated. 
This amount must be $0.00 to record the transaction. 

6 Click OK to close. If multiple departments were assigned, Split 
will appear in the departments field.

7 Click Record.

To assign multiple departments to a deposit adjustment

1 Go to the Banking command center and click Prepare Bank 
Deposit. The Prepare Bank Deposit window appears. 

2 Select from the transactions listed the amounts you want to 
deposit. 

3 If you need to enter an adjustment transaction—for example, to 
record credit card transaction fees or to keep part of the deposit 
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as cash—click Deposit Adjustment. The Bank and Deposit 
Adjustments window appears.

4 In the Fees and Cash Back and/or the Adjustment for Excess 
Funds fields:
a Type the adjustment amount.
b Type the date and an ID number.
c Select an expense or income account—as appropriate—for the 

adjustment amounts.
d Type a description in the Memo field and complete other fields 

as necessary.
e Click in the Dept field. The Allocate Departments window 

appears displaying the departments already created. 
f Select either Amount or Percentage for the allocation and 

either the amount or percentage for each department 
selected. The amount of the adjustment entered will be 
displayed as the amount left to be allocated. This amount must 
be $0.00 to record the transaction. 

g Click OK to close. If multiple departments were assigned, Split 
will appear in the departments field.

h Click Record. 
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If you need to record additional adjustments or fees, click 
Deposit Adjustment again.

5 Click Record to record the bank deposit.

Back to What’s New 

Tracking Leads

You can create a lead card to begin tracking potential customers. If 
you have created a quote for someone that is not yet a customer 
creating a lead card will give you the ability to track the source and 
the status of the potential customer. Once the person or company 
accepts the quote, when you change it to an order or an invoice, the 
lead card will automatically be changed to a customer card. The date 
the lead card was created will remain in the history of the customer 
card along with all contact information. 

The lead source and lead status fields remain in the Card Details tab 
of the customer card. The Lead Since in the History tab also retains 
the date the lead was created. 

To create a lead card

1 Go to the Card File command center and click Cards List. The 
Cards List window appears.

2 Select the Lead tab and click New. The Card Information 
window appears.

3 Lead is selected from the Card Type list.

4 Select the designation of the card: company or individual.
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5 Type the leads name and press TAB. Additional fields appear.

6 Enter a code to identify this lead in the Card ID field. For more 
information, see ‘Card identification codes’.

7 Enter contact details for the lead. 

If you want to enter more contact information, select another 
address from the Location list and enter the additional details. 
You can enter contact details for five different locations.

8 Click the Card Details tab. You can enter notes about the 
customer, insert a picture and assign attributes to group and sort 
the card.

If you want to... See

insert a picture Card 
pictures

assign identifiers to the card Identifiers

assign an attribute from a custom list Custom lists

enter additional information in a custom field Custom 
fields
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9 Click the Selling Details tab and select the selling information. 

10 Click the Payment Details tab and select the method of payment 
your lead will use to pay you once they have become a customer. 

11 Click the Reminder Log tab and create a new reminder and to 
view reminders created.

12 Click the Jobs tab to view a list of jobs this lead is linked to. For 
more information about jobs, see ‘Jobs’.

13 Click the History tab to view all transactions assigned to this lead. 
The date the lead card is created is automatically entered in the 
Leas Since field but you can also enter the date that the contact is 
created. The lead since date remains when the lead card is 
changed to a customer card.

14 Click OK to close the Card Information window.

Back to What’s New 

Update AccountEdge date

AccountEdge now has the ability to determine if the date set in the 
program is the same as the current system date. In the past, if 
AccountEdge was left open overnight, the date of the system would 
change but the date in AccountEdge would remain the same until 
the company file has been closed and reopened. 

enter default department Departmen
ts

assign an attribute from a lead source and status Lead Source 
and Status

If you want to... See
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Now, if AccountEdge has been left open overnight, as soon as the 
user begins to work in AccountEdge a message will alert the user that 
the dates may be different. You will be able to update AccountEdge 
date to match the current date without having to close and reopen 
your company file. 

To update AccountEdge dates

1 Go to the File menu at any command center and select Update 
AccountEdge Dates. The Update AccountEdge Dates window 
will appear. 

2 Enter the date in the Update Date field you want to use for the 
transactions in your company file.

3 Click Update. 

Back to What’s New 
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Easier navigation for invoices and 
bills

Back and Forward arrows have been added to quotes, orders, 
invoices and bills for easier navigation without having to close the 
window and go into the registers. 

Simply click on either the back or forward arrow to view either the 
last or next quote, order, invoice or bill recorded by number 
sequence. If the transaction has not yet been recorded, the arrows 
will show the last transaction recorded. 

When you are in a sale only the invoices will show and when in 
purchases only the bills will show. 

Back to What’s New 
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Purge Sale/Purchase Quotes and 
Cards

With the ability of creating and tracking leads and customers you 
also have an assistant to help you through the process of purging 
sales/purchase quotes and cards from your company file. 

For customers and leads, you can purge quotes and their associated 
cards that haven’t been converted to sales and are no longer needed. 
This assistant will step you through the process of first purging the 
transactions then the associated cards. 

A new purge button has been added to the Cards List menu to purge 
lead, customer and supplier cards. This button will take you to the 
Purge Sales Quotes and Cards window or the Purge Purchase 
Quotes and Cards window.
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All purging options, listed below, can now be found under the File 
menu. 

 Journal Entries
 Closed Invoices
 Sale Quotes and Cards
 Activity Slips
 Closed Bills
 Purchase Quotes and Cards
 Timesheets
 Item Movements
 Serial Numbers
 Reminder Logs

Back to What’s New 

HMRC changes

[For AccountEdge Plus and Network Edition users only]

 Student Loan Deduction changes 

From April 2016 there will be 2 thresholds for Student Loan 
Deductions. Your software can calculate the deduction amount on 
the paycheques but will need to have the Plan Type used by the 
employee selected. 

In the employee’s card payroll information deductions window, if the 
payroll year is 2017 the option to select the Student Loan Deduction 
Plan Type 1 or 2 will become available.

If the payroll year is 2016 there is only one threshold rate used to 
calculate the deduction.

 Scottish Rate of Income Tax
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From April 2017 the Scottish Government can vary the rate of 
Income Tax (PAYE). This rate is determined by the employees tax 
code. If the first letter of an employees tax is “S” then the Scottish 
rate (SRIT) should be used. For 2017 the Scottish rate will be the 
same as the rest of UK. 

When processing payroll for the payroll year 2017 and later, if the 
employees tax code is prefixed by ‘S’, the Scottish Income Tax rates 
will be used for tax calculations. 

The 2017 tax rates have not changed with the exception of the UEL 
(Upper Earning Level) threshold being increased and the UAP (Upper 
Accrual Point) being removed. 

RTI - Full Payment Submission (FPS) file will NOT show the ‘S’ prefix.

 NIC Category (Letter) changes - End of Contracting Out

From April 2016 pension schemes will no longer use a contracted-
out salary related (COSR) occupational pension scheme to contract 
out of the State Scheme. 

If the payroll year is 2017 then only the following NI letters are valid: 
A Standard Rate

B Reduced Rate

C (Pensioners) Rate

H Apprentice Rate (Under 25)

J Deferred Rate

M Standard Rate (Under 21)

Z Deferred Standard Rate (Under 21)

X No contributions due

ECON and SCON fields are only required when Contracted-Out NI 
contributions are used.

 Apprentice NIC category

New Apprentice NI category - NI Table Letter ‘H’. 

From 6 April 2016 a zero rate of Class 1 Secondary contributions has 
been introduced for apprentices under the age of 25.
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To use this category the employee must be apprentices and under 
the age of 25. 

 Flexible Pension Drawdown payments

From payroll year 2017 HMRC requires some pension payments, 
‘Flexible Pension Drawdown’ payments and ‘Pension Death Benefit’ 
payments to be reported in the FPS submission. The Flexible Pension 
Drawdown, Pension Death Benefit and Trivial Commutation 
Payment are mutually exclusive. They are not displayed if the payroll 
year is 2016 or earlier. 

 RTI FPS part of the Contracting

As part of the Contracting-Out changes the ECON field has been 
removed from the submission for payroll year 2017 onwards. 

 Employer Allowance

For the 2016 to 2017 payroll tax year the Employer Allowance has 
been increased from £2000.00 to £3000.00

Back to new Features List
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Departments added to Inventory 
Adjustments

A department field has been added to the Adjust Inventory window. 
If more than one department has been added to a transaction, split 
will appear in the department field. The amounts of each 
department selected must equal the total amount of transaction. 

NOTE : Assigned multiple departments to a transaction If you 
assign a department or multiple departments to a transaction you 
must first select the preference I Use Departments; if 
Departments Are Not Assigned to All P&L Accounts 
Warn, Don’t Warn [System-wide]. 

To assign multiple departments to an inventory 
adjustment

1 Go to the Inventory command center and click Adjust 
Inventory. The Adjust Inventory window appears.

2 Enter the number of the item you need to adjust. Enter 
appropriate information for all other fields including the amount 
of the adjustment. 
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3 Click in the Dept field. The Allocate Departments window 
appears displaying the departments already created. 

4 Select either Amount or Percentage for the allocation and either 
the amount or percentage for each department selected. The 
amount of the adjustments entered will be displayed as the 
amount left to be allocated. This amount must be $0.00 to 
record the transaction.

5 Click OK. The Adjust Inventory window re-appears. 

6 Click Record after all other information has been added. 

7 Years Historical reporting

You can now view up to 7 years of Profit & Loss and Balance Sheet 
reports in AccountEdge. Also, a new multi-year spreadsheet report is 
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included which displays year over year P&L comparison in easy to 
view columns. 

You can select prior years on the following reports:
 Standard Profit & Loss
 Profit & Loss Multi-Period Spreadsheet
 Profit & Loss Year to Date
 Profit & Loss Multi-Year Spreadsheet
 Standard Balance Sheet
 Multi-period Balance Sheet

If the financial year has been closed and/or the financial data was 
purged prior to upgrading to AccountEdge 2016, the columns will 
be blank. 

Back to new Features List
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Profit Analysis reports

New reports based on customer profitability have been added to 
AccountEdge. Now, you can see how profitable certain customers 
are based on the items sold to them and their margin. Also included 
are a new set of Item Profitability reports to show you your most and 
least profitable items. 

The new reports are: 

Profit Analysis - Item Summary report

Profit Analysis - Item Sales Summary report

Profit Analysis - Item Sales Detail report

Profit Analysis - Activity Summary report

Profit Analysis - Activity Sales Summary report

Profit Analysis - Activity Sales Detail report

Profit Analysis - Customer Summary report

Profit Analysis - Customer Sales Summary report

Profit Analysis - Customer Sales Detail report

Back to new Features List

Lead reports

New reports based on leads and leads that become customers have 
been added to AccountEdge. You can easily track a lead from the 
beginning through to becoming a customer. You also have the 
reporting tools to analyse the sources and status of each lead. 
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The new reports are: 
 Lead Quote Summary report
 Lead Quote Detail report
 Lead Source report - Sales
 Lead Source report - Card File
 Lead Status report
 Lead Aging report
 Lead Conversion report

Back to new Features List
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